Создаём таинственный коллаж в Фотошоп

Создайте таинственный плавающий куб в заброшенной долине. Данное изображение, наводящее на размышления, можно создать с помощью различных стоковых изображений и нескольких кистей Photoshop – а я покажу вам, как это осуществить. Вы узнаете технику создания 3D куба из текстур, мы поработаем над светотенями и применим цветовую коррекцию.

Итоговый результат

Исходные материалы:
Гроза в долине
Здание лаборатории
Белый куб
Бетонная стена 3
Девушка
ШАГ 1 - Создайте Новый Документ
Давайте создадим новый документ, идём Меню – Файл – Новый (Menu >File > New), и применяем следующие настройки в соответствующих полях:
Набор (Presets): Заказной (Custom)
Ширина (Width): 1920 px
Высота (Height): 1040 px
Разрешение (Resolution): 300 pх/дюйм
Цветовой режим (Color Mode): RGB Color; 8 bit
Содержимое фона (Background Contents): Прозрачный (Transparent)
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ШАГ 2 - Создайте Задний фон – Небо 
В этом шаге, мы создадим небо для нашей композиции. Для начала, откройте изображение Гроза в долине. Как только открылось стоковое изображение, выберите инструмент Прямоугольная область [image: image2.png]


(Rectangular Marquee tool), нажав клавишу M и далее, выделите часть неба. См. скриншот ниже:
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[image: image4.jpg]



Как только вы выделили небо, выберите инструмент Перемещение [image: image5.png]


(Move tool (V), щёлкните левой кнопкой мыши по выделенной области и зажимая левой кнопкой выделенную область, переместите выделенное изображение на наш документ. Обратите внимание, что размеры изображения с небом превышают размеры нашего документа, поэтому, когда вы переместите выделенную область неба на наш документ, необходимо будет уменьшить масштаб неба.

Переместите и расположите выделенное изображение с небом, как показано на скриншоте ниже:

[image: image6.jpg]



Итак, мы расположили небо, далее переименуйте этот слой в "небо".

Для того, чтобы переименовать слой, просто дважды щёлкните по тексту: "слой 1" (текстовое окно расположено рядом с миниатюрой слоя), чтобы текстовое окно стало активным. Как только оно станет активным, вы можете переименовать слой. См. скриншот ниже:
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Далее, выберите инструмент Трансформация (Transform tool (Ctrl+ T) и масштабируйте изображение, как показано на скриншоте ниже:
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Результат должен быть, как на скриншоте:
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Далее, давайте затемним небо; для этого, убедитесь, чтобы слой "небо" был активным, а затем создайте новый слой Ctrl + Shift + N. Данное действие необходимо, чтобы новый слой автоматически был создан поверх активного слоя. Итак, когда появится диалоговое окно при создании нового слоя, назовите это слой "затемнённое небо". См. скриншот ниже:
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Итак, как только вы создали новый слой, выберите инструмент Кисть [image: image14.png]


(Brush tool (B), но переде тем, как мы приступим, убедитесь, чтобы кисти были установлены по умолчанию. Стандартные кисти Photoshop по умолчанию показаны на скриншоте ниже, если у вас установлены другие кисти, то следуйте инструкции на скриншоте ниже:
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Щёлкните правой кнопкой мыши по документу, слой и кисть при этом должны быть активными, а затем нажмите значок, который выделен жёлтым цветом:
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Когда появится контекстное меню, выберите опцию Восстановить кисти (Reset Brushes).
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Теперь, когда вы восстановили кисти, примените следующие значения для кисти:
Размер кисти (Brush size): 1000px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 15%
Нажим (Flow): 100%
Цвет(Color) #: 00011b
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Примечание #: 00011b означает номер цветового оттенка кисти. Для того, чтобы поменять цветовой оттенок кисти, просто следуйте инструкции на скриншоте ниже:
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Как только появится окно Палитра цветов (Color Picker), примените следующие значения:
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Итак, цвет кисти мы установили тёмно-синий, давайте, применим кисть!
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Результат:
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Шаг 3 - Создайте Задний фон - Пустыню
В этом шаге, мы завершим создание заднего фона, путём добавления заброшенной земли. Для начала, откройте изображение "Здание лаборатории". Как только открылось изображение, выберите инструмент Прямоугольная область[image: image23.png]


 (Rectangular Marquee Tool (M) и создайте выделение, как показано на скриншоте ниже:
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Как только вы создали выделенную область, выберите инструмент Перемещение [image: image25.png]


(Move tool (V) и переместите выделенное изображение на наш документ. Расположите, как показано на скриншоте ниже:
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Переименуйте этот слой в "долину". Далее, выберите инструмент Трансформация (Transform tool (Ctrl + Shift + T) и масштабируйте изображение, как показано на скриншоте ниже:
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Результат должен быть, как на скриншоте:
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Далее, нам нужно совместить заброшенную долину со светлой частью неба. Для этого, создайте новый слой (Ctrl + Shift + N) и назовите этот слой "осветление".

Далее, щёлкните правой кнопкой мыши по новому слою и выберите опцию Создать обтравочную маску  (Create Clipping Mask), таким образом, действие кисти будет применено только к слою "осветление".
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Выберите кисть и примените следующие значения:
Размер кисти (Brush size): 300px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 15%
Нажим (Flow): 100%
Цвет(Color) #: ffffff
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Итак, давайте, применим кисть:

[image: image33.jpg]



Результат:
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Далее, мы добавим больше света к горизонту, чтобы он выглядел более эффектным. Перед началом, создайте новый слой Ctrl + Shift + N и назовите этот слой "исправление горизонта 1".

Выберите кисть и примените следующие значения:
Размер кисти (Brush size): 500px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 15%
Нажим (Flow): 100%
Цвет(Color) #: fffdc5
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Сейчас, давайте, применим кисть:
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Результат должен быть, как на скриншоте:
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Далее, создайте новый слой Ctrl + Shift + N и назовите этот слой "исправление горизонта 2". Выберите кисть и примените следующие значения:
Размер кисти (Brush size): 1000px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 15%
Нажим (Flow): 100%
Цвет(Color) #: fffff3
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Итак, давайте усилим горизонт во второй раз:
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Результат:
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Далее, давайте затемним землю, чтобы свет выглядел более драматично и эффектно. Создайте новый слой Ctrl + Shift + N, назовите этот слой "затемнение земли".

Выберите кисть и примените следующие значения:
Размер кисти (Brush size): 600px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 25%
Нажим (Flow): 100%
Цвет(Color) #: 000000
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Итак, давайте, применим кисть:
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Результат должен быть, как на скриншоте:

[image: image43.jpg]



Как только вы закончили, выделите все слои, которые мы создали и нажмите клавиши Ctrl + G, чтобы сгруппировать их. Как только вы создали новую группу, переименуйте её в "Задний фон".

[image: image44.jpg]| Layers x | Channels | Paths





Шаг 4 - Создайте Таинственный Куб
Сейчас мы создадим плавающий куб. Для начала, откройте изображение "Белого Куба 1". Нам необходимо отделить куб от заднего фона, для этого нам потребуется инструмент Прямолинейное Лассо [image: image45.png]


(Polygonal Lasso Tool (L).
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Как только данный инструмент стал активным, создайте выделение вокруг куба:

[image: image47.jpg]



Далее, выберите инструмент Перемещение [image: image48.png]


(Move tool (V) и переместите куб на наш документ. Переименуйте этот слой в "куб". Убедитесь, чтобы слой с кубом был расположен поверх группы "Задний фон".
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Расположите, как на скриншоте ниже:

[image: image50.jpg]



Далее, выберите инструмент Трансформация [image: image51.png]


(Transform tool (Ctrl + T) и масштабируйте куб, как показано на скриншоте ниже:
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Результат:
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Шаг 5 - Создайте Текстуру для Таинственного Куба
В этом шаге, мы применим текстуру к кубу, чтобы он выглядел более реалистичным. Предыдущий шаг послужит нам примером при трансформации текстуры, которую мы применим к кубу.

Для начала, откройте текстуру "Бетонная Стена 3". Итак, мы не будем использовать всё изображение текстуры, вместо этого, мы просто вырежем часть текстуры, которую применим к каждой стороне куба. Выберите инструмент Прямоугольная область [image: image55.png]


(Rectangular Marquee tool (M) и создайте выделение в районе области, как показано на скриншоте ниже:
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Как только вы создали выделенную область, выберите инструмент Перемещение [image: image57.png]


(Move tool (V)) и переместите выделенное изображение текстуры на наш документ, как показано на скриншоте ниже:

[image: image58.jpg]



Далее, переименуйте слой в "сторона 1".

Итак, пришло время применить искажение к этому слою. Чтобы применить искажение. Выберите инструмент Трансформация (Transform tool (Ctrl+ T), щёлкните правой кнопкой по документу, чтобы появилось контекстное меню. Как только появится окно контекстного меню, выберите опцию Искажение (Distort).
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Следуйте инструкциям по искажению "сторона 1", как показано на скриншотах ниже:
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[image: image61.jpg]
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Результат должен быть, как на скриншоте:
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Далее, нам необходимо затемнить этот слой, чтобы совместить с закатом. Перед началом, создайте новый слой Ctrl + Shift + N, назовите этот слой "затемняем сторону 1". Щёлкните правой кнопкой мыши по этому слою, а затем выберите опцию Создать обтравочную маску (Create Clipping Mask), чтобы акцентировать кисть только на этом слое.

Как только вы создали обтравочную маску, активируйте инструмент кисть, а затем примените следующие значения для кисти:
Размер кисти (Brush size): 150px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 15%
Нажим (Flow): 100%
Цвет(Color) #: 0f0600
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Примечание: Мы применим тёмно-коричневый оттенок для кисти вместо чёрного цвета, тем не менее, оттенки тени будут отвечать оттенкам изображения.

Итак, давайте, затемним текстуру:

[image: image66.jpg]



Результат должен быть, как на скриншоте:
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Сейчас, мы создадим текстуру для верхней правой стороны куба. Ещё раз откройте текстуру "Бетонная Стена 3". Выберите инструмент Прямоугольная область [image: image68.png]


(Rectangular Marquee tool (M) и создайте выделение в районе области, как показано на скриншоте ниже:

[image: image69.jpg]



Активируйте инструмент Перемещение [image: image70.png]


(Move tool (V) и переместите выделенное изображение на наш документ. Переименуйте этот слой в "сторона 2" и поместите поверх слоя "затемняем сторону 1".

Расположите текстуру, как показано на скриншоте ниже:
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Далее, выберите инструмент Трансформация (Transform tool (Ctrl + T), щёлкните правой кнопкой мыши по документы и выберите опцию Искажение (Distort) и примите искажение, как показано на скриншоте ниже:
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Результат:
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Сейчас, мы затемним "сторону 2", поэтому, создайте новый слой Ctrl + Shift + N, назовите этот слой "затемняем сторону 2". Как только вы создали новый слой, к новому слою примените обтравочную маску.

Выберите кисть и примените следующие значения:
Размер кисти (Brush size): 150px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 15%
Нажим (Flow): 100%
Цвет (Color) #: 0f0600

Давайте, применим кисть!
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Результат должен быть, как на скриншоте:
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Далее, мы создадим текстуру для верхней левой стороны. Выберите инструмент Прямоугольная область [image: image79.png]


(Rectangular Marquee tool (M), ещё раз откройте текстуру "Бетонная Стена 3", а затем создайте выделение в районе области, как показано на скриншоте ниже:

[image: image80.jpg]



Итак, выберите инструмент Перемещение [image: image81.png]


(Move tool (V) и переместите выделенное изображение текстуры на наш документ. Переименуйте этот слой в "сторону 3". Расположите текстуру, как показано на скриншоте ниже:

[image: image82.jpg]



 

Выберите инструмент Трансформация (Transform tool (Ctrl+ T) и выберите опцию Поворот на 90 против часовой (Rotate 90 CCW) в контекстном меню.

[image: image83.jpg]Free Transform

Scale
Rotate
Skew
Distort
Perspective
Warp

Rotate 180°
Rotate 90° CW
Rotate 90° CCW

Flip Horizontal
Flip Vertical





Результат:

[image: image84.jpg]



Далее, примените искажение, как показано на скриншоте ниже:
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Результат должен быть, как на скриншоте:

[image: image89.jpg]



Сейчас, давайте затемним эту сторону куба, чтобы совместить со световой частью изображения, создайте новый слой Ctrl + Shift + N, назовите этот слой "затемняем сторону 3", а затем к этому слою создайте обтравочную маску.

Выберите кисть и примените следующие значения:
Размер кисти (Brush size): 150px
Жёсткость (Hardness): 0%
Непрозрачность (Opacity): 15%
Нажим (Flow): 100%
Цвет (Color) #: 0f0600

Итак, давай, применим кисть:

[image: image90.jpg]



Результат должен быть, как на скриншоте:
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Примечание: чтобы легче было применять искажение, вы можете отключить видимость самого куба.  Вам будет легче применить искажение, однако не будет ориентиров. Видимость слоя можно также включить:
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Сейчас, выделите все слои, которые вы создали в Шаге 4 и сгруппируйте их Ctrl + G, назовите группу "Куб".

Шаг 6 - Добавляем Путника
В этом шаге мы добавим девушку, которая зачарованно смотрит на куб. Для начала, откройте изображение "Девушки". Нам необходимо отделить девушку от фона и создать выделение вокруг неё, для этого мы используем инструмент Магнитное лассо [image: image93.jpg]


(Magnetic Lasso Tool).
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Как только вы выбрали магнитное лассо, создайте выделение вокруг девушки.
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Выберите инструмент Перемещение [image: image96.png]


(Move tool (V)) и переместите выделенное изображение девушки на наш документ. Как только вы переметили девушку, назовите слой "девушка". Расположите изображение девушки, как показано на скриншоте ниже:

[image: image97.jpg]



Сейчас, нам понадобиться уменьшить масштаб девушки, поэтому, выберите инструмент трансформацию и уменьшите масштаб, как показано на скриншоте ниже:

[image: image98.jpg]



Далее, ещё раз активируйте инструмент  трансформация, щёлкните правой кнопкой по документу и выберите опцию Отразить по горизонтали (Flip Horizontal) в контекстном меню.
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Результат:

[image: image100.jpg]



Сейчас, давайте выберем инструмент перемещение и переместим изображение девушки на новое место, которое расположено немного под кубом. См. скриншот ниже:

[image: image101.jpg]



Далее, давайте откорректируем яркость / контрастность нашей девушки. Для этого, вначале выделите слой с девушкой, а затем идём Изображение – Коррекция – Яркость / Контрастность (Image > Adjustments > Brightness/Contrast):

Как только появится окно настроек, примените следующие значения:
Яркость (Brightness): 22
Контрастность (Contrast): -12
Использовать прежние (Use Legacy): Поставить галочку (Check)
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Результат:

[image: image103.jpg]



Далее, давайте, откорректируем свет изображения, для этого, выделите слой с девушкой, а затем идём Изображение – Коррекция – Цветовой Тон / Насыщенность (Image > Adjustments > Hue/Saturation).

Как только появится окно настроек, примените следующие значения:
Редактировать (Edit): Всё (Master)
Цветовой тон (Hue): 0
Насыщенность (Saturation): 0
Яркость (Lightness): -30

[image: image104.jpg]Hue/Saturation

Saturation: 0

[Clcolorize





Результат:

[image: image105.jpg]



Далее, нам нужно создать плавный переход между изображением девушки и остальным изображением, для этого, нам понадобится Ластик [image: image106.png]


(Eraser tool (E).
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Как только вы выбрали инструмент Ластик [image: image108.png]


(Eraser tool (E), примените следующие значения:
Размер кисти (Brush size): 200px
Непрозрачность (Opacity):  100%
Нажим (Flow): 100%
Масштаб (Zoom level) : 400%

[image: image109.jpg]»
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Чтобы поменять масштаб, просто идём Окно – Навигатор (window – Navigator) и увеличиваем масштаб до 400%
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Итак, примените ластик:

[image: image111.jpg]



Результат:

[image: image112.jpg]



Шаг 7 - Добавляем тень к Девушке
В этом шаге, мы добавим тень к девушке. Для этого, выделите слой с девушкой и продублируйте его, нажав клавиши Ctrl + J. Как только вы создали дубликат слоя, выберите инструмент трансформация, далее щёлкните правой кнопкой мыши по документу и выберите опцию Отразить по вертикали (Flip Vertical).

Результат:

[image: image113.jpg]



Активируйте инструмент перемещение и переместите немного вниз, чтобы выглядело, как будто это отражение девушки:

[image: image114.jpg]



Сейчас, выберите инструмент трансформация, щёлкните правой кнопкой мыши по документу и выберите опцию Искажение (Distort). Далее, примените искажение, как показано на скриншоте ниже:

[image: image115.jpg]
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Результат должен быть, как на скриншоте:

[image: image117.jpg]



Сейчас, мы преобразуем изображение в реальную тень, вначале идём Изображение – Коррекция – Яркость / Контрастность (Image > Adjustments > Brightness/Contrast) и применяем следующие значения:
Яркость (Brightness): -100
Контрастность (Contrast): -100
Использовать прежние (Use Legacy): Поставить галочку (Check)
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Результат:

[image: image119.jpg]



Далее, мы применим размытие к тени, чтобы она выглядела правдоподобно. Для этого, выделите слой с тенью, а затем идём Фильтр- Размытие – Размытие по Гауссу (Filter > Blur > Gaussian Blur). Итак, когда появится окно настроек, примените следующие значения:
Радиус (Radius): 1.0 px

[image: image120.jpg][ Preview





Результат:

[image: image121.jpg]



Сейчас, мы уменьшим непрозрачность слоя с тенью. Уменьшите непрозрачность слоя до 70%.
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Далее, выделите все слои, которые вы создали в Шаге 6 и сгруппируйте их Ctrl+ G, назовите группу "Девушка".

Шаг 8   Усиливаем Общий Вид Изображения
Сейчас, давайте, усилим общий вид и общее чувство изображения. Для начала, давайте, создадим новый корректирующий слой Цвет (Solid Color), для этого нажмите кнопку в нижней панели инструментов Создать новый корректирующий слой или слой- заливку (Create New Fill/Adjustment layer).
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Как только появится контекстное меню, выберите опцию Цвет (Solid Color):
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Как только вы выбрали опцию Цвет (Solid Color), появится окно Палитра цветов (Color Picker). Итак, примените следующий цветовой оттенок:
#: 00022c
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Нажмите OK, а затем поменяйте режим наложения и непрозрачность этого слоя на следующие значения, которые указаны ниже.

Примечание: режим наложения можно поменять в верхней панели в палитре слоёв. Окно непрозрачности слоя расположено рядом.

Режим наложения (Blending mode): Исключение (Exclusion)
Непрозрачность (Opacity): 50%

[image: image126.jpg]



Убедитесь, чтобы этот слой был расположен поверх группы "девушка". Далее, давайте, создадим новый корректирующий слой Цветовой баланс (Color Balance), для этого нажмите кнопку в нижней панели инструментов Создать новый корректирующий слой или слой- заливку (Create New Fill/Adjustment layer).
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Когда появится окно настроек, примените следующие значения:
Уровни (Color Levels): +17, -12, -10
Тоновый баланс (Tone Balance): Средние тона (Midtones)
Сохранить свечение (Preserve Luminosity): Поставить галочку (Check)
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Далее, давайте, создадим ещё один корректирующий слой Уровни (Levels), для этого нажмите кнопку в нижней панели инструментов Создать новый корректирующий слой или слой- заливку (Create New Fill/Adjustment layer).
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Как только откроется окно настроек, примените следующие значения:
Канал (Channel): Красный (Red)
Входные значения (Input Levels): 15, 1.00, 255
Выходные значения (Output Levels): 0, 255
Канал (Channel): Синий (Blue)
Входные значения (Input Levels): 15, 1.00, 255
Выходные значения (Output Levels): 0, 255
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Далее, давайте применим ещё один корректирующий слой Фото фильтр (Photo Filter), для этого нажмите кнопку в нижней панели инструментов Создать новый корректирующий слой или слой- заливку (Create New Fill/Adjustment layer).
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Как только откроется окно настроек, примените следующие значения:
Фильтр (Filter): Violet
Плотность (Density): 25%
Сохранить свечение (Preserve Luminosity): Поставить галочку (Check)
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Далее, давайте, создадим новый корректирующий слой Яркость / Контрастность (Brightness/Contrast), для этого нажмите кнопку в нижней панели инструментов Создать новый корректирующий слой или слой- заливку [image: image135.png]


(Create New Fill/Adjustment layer).
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Как только откроется окно настроек, примените следующие значения:
Яркость (Brightness): -10
Контрастность (Contrast): 10
Использовать прежние (Use Legacy): Галочку не ставить (Uncheck)
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Далее, давайте, создадим ещё один корректирующий слой Цветовой баланс (Color Balance) и как только откроется окно настроек, примените следующие значения:
Уровни (Color Levels): 0, -15, 0
Тоновый баланс (Tone Balance): Средние тона (Midtones)
Сохранить свечение (Preserve Luminosity): Поставить галочку (Check)

Примечание переводчика: автор не указал скриншот в уроке для цветового баланса, тем не менее, у нас есть значения, которые мы можем применить.
Сейчас, давайте создадим корректирующий слой Карта градиента (Gradient Map),  для этого нажмите кнопку в нижней панели инструментов Создать новый корректирующий слой или слой- заливку (Create New Fill/Adjustment layer).
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Сейчас, когда появится окно настроек Карты градиента, следуйте инструкции на скриншоте ниже:
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Вы заметите, что ваше изображение стала Чёрно- белым, поэтому, поменяйте режим наложения и непрозрачность слоя на следующие значения:
Режим наложения (Blending mode): Свечение (Luminosity)
Непрозрачность (Opacity): 60%
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Результат должен быть, как на скриншоте:
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Итоговый результат
[image: image142.jpg]
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